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Colour Management Basics

Colour Management in a Prepress Environment

Input, output and viewing devices use different colour modes to capture, display or print  
images. The various colour modes differentiate greatly in the amount of colours they can  
reproduce. For example, a digital camera captures RGB light with a wider gamut than  
what is reproduced when printed in CMYK mode onto paper.

In a prepress workflow, a colour management system will provide consistent and predictable 
results when using multiple devices with various colour gamuts. Colour Profiles control the 
colour matching between the different devices. They define a viewing intent and are also  
used in the conversion process from one colour mode to another (e.g., RGB to CMYK).

Colour Management Essentials

• Calibrated Monitor 
• Proper workspace and viewing lighting conditions 
• Proper use of colour profiles 
• Proper use of Colour Management System (CMS) in the applications

RGB Colour Gamut

CMYK Colour Gamut

Camera	 Scanner	 Monitor	 CMYK Printing Press
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Colour Management Basics

Gamut 

Gamut refers to the colour range a viewing or output device is capable of displaying  
with ink on paper or other means of colouration.

The graphic below represents the visible spectrum the human eye can see and the  
possible range of each of the two different RGB colour spaces, as well as the gamut  
constraint of the CMYK colour mode.

Visible to the Human Eye
Adobe RGB
sRGB
CMYK

All digital printers have device-dependent 
colour spaces. Even though a particular 
device, such as a printer, may use the 
CMYK colour space, the colours it renders 
for specific CMYK values are often slight-
ly different than all other types of CMYK 
printers. For example, printing a CMYK for-
mula of 80/20/60/5 on Printer A & Printer 
B would result in two greens that do not 
look exactly the same. To match Printer B to 
Printer A the CMYK values used on Print-
er B would need to be tweaked to a new 
formula (eg. 83/19/61/4). Furthermore, each 
CMYK printer has a slightly different CMYK 
gamut; therefore a CMYK colour produced 
on Printer A might not be reproducible on 
Printer C. Hemlock Display recommends 
supplying a Pantone number to your Sales 
Representative for matching colour critical 
projects.
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Colour Management Basics

Colour Profiles 

RGB Colour Profiles

Most input devices such as cameras and scanners will assign a profile when saving the file. 
These RGB profiles are an integral part of a colour managed workflow. The profiles define a 
viewing intent and play a role in how an image will convert from one colour mode to another 
(e.g. RGB to CMYK). It is therefore important to embed the profile when saving an image from 
Photoshop. 

Saved image with embedded colour profile.

Same RGB image with different outcomes:

The “Embed Color Profile” ... must be 
checked to avoid unexpected results in 
a colour managed prepress workflow. 

Saved image without colour profile. A default colour 
profile was used when converted from RGB to CMYK.
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Colour Management Basics

The most common RGB profiles are:

•	 Adobe RGB (1998) - has a larger range of colours (gamut) and is considered the standard 
for a prepress workflow.

•	 sRGB IEC61966-2.1 - is considered an alternative profile to Adobe RGB (1998). sRGB 
ICE61966-2.1 is intended to look good for viewing on a monitor and most output situations. 
However, conversion errors from RGB to CMYK are more likely to occur when using sRGB 
ICE61966-2.1 rather than Adobe RGB (1998).

Hemlock Display’s recommended input profile is Adobe RGB (1998).

CMYK Colour profiles

If you are planning on converting RGB to CMYK, it is important to choose the correct output 
(CMYK) profile for the specific requirements of a project. Hemlock Display recommends 
using GRACoL 2006 (ISO 12647-2:2004) as an output profile as it reproduces colour the best 
across our printers. It is one of the many CMYK output profiles available in Photoshop.

Converting from RGB to CMYK can be performed in the following places:

•	 Photoshop
•	 InDesign when exporting the pages to PDF
•	 Illustrator when saving as a PDF
•	 Hardware/Software systems that control the output device
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Colour Management Basics

Setting Up a Colour Managed Work Flow in Adobe CC 

Color Settings File (CSF) in Photoshop

To ensure colour consistency throughout all applications in Adobe CC, the correct CSF  
must be installed and synchronized.

Photoshop’s Color Settings:

A Color Settings File (CSF) can be requested from Hemlock Display in order to match our  
specifications.
 
It is also possible to create a custom CSF. Go to: Photoshop > Edit > Color Settings  
and save the CSF file. It can then be synchronized with other Adobe applications.
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File Preparation for Large Format Printing

Large Format Printing

The page set-up requirements and the handling of fonts and PANTONE colours are different 
than what is commonly used in an offset or small format digital print environment. Please read 
this file preparation guide to learn how to submit files for large format print projects. Follow-
ing these few simple steps will ensure a trouble-free prepress process and a timely delivery of 
your order. It will also reduce the risk of incurring additional costs.
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Large Format Printing

Document Set-Up

When starting with a print project you must ensure that the 
following is entered in the New Document set-up menu cor-
rectly:

	 Document size = Trim

It is recommended to set-up your document size at 100% 
scale (final output size). This will allow you to confirm the 
final input resolution of placed images and the required bleed 
allowances.

Bleed is the extra image that is added to your design to make 
sure there is no white border when the job is trimmed or fold-
ed for hemmed edges.

The standard bleed requirement for Large Format work is 
0.25” minimum all sides except for large wall/window graph-
ics and/or hemmed banners where the bleed requirement is 
1” minimum all sides (2” bleed is preferred). Depending on 
the application of the graphic some projects can require up to 
4” of bleed. For example, a wall might not be completely level 
or straight along the top and bottom edge and could require 
4” of bleed to position the graphic in the correct spot. Please 
contact your Sales Representative for guidance on bleed set-
tings when it comes to challenging applications.

Please verify that all images, graphics and flat tints meet the 
bleed requirements as noted above.
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Large Format Printing

Document Set-Up cont’d

The reason for the relatively large amount of bleed requirement is the challenge of handling 
large materials in the printing and finishing machines as well as the less than perfect front-to-
back registration in the Wide Format printing process. 

In the case of window and wall graphics, the large amount of bleed will aid in the installation 
process. The extra bleed will account for any uneven surface and any movements needed to 
create a seamless look.

Image Resolution

When it comes to determining image resolution for offset or small format printing, a general 
rule is to use a resolution that is twice that of the output linescreen, or about 300-400 PPI. 
An image with more than 300-400 PPI will result in a file size that increases exponentially 
without any appreciable increase in quality. An image with less than 300-400 will yield 
jaggedness in edges and areas of contrast

Large format printed products such as banners, wall graphics, fleet graphics, or semi-trailer 
graphics can be larger than 10’ x 20’. A 10’ x 20’ image with a resolution of 400 PPI would 
result in an almost unworkable 17GB file size. Therefore resolution settings need to be tailored 
for each specific large format product.

The three factors to take into account for determining image resolution are:

•	 Viewing Distance (pages 12-13)
•	 Viewing Conditions (page 14)
•	 Type of image (page 14)
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Large Format Printing

Viewing Distance

The ability for the human eye to discern detail is known as visual acuity. The maximum acuity 
in the human eye is related to the diameter of the light sensing cones and rods on the retina 
which mathematically translates to an angle (30 seconds of an arc). As we view things from 
further away our ability to resolve detail diminishes.

To determine a standard for what resolution to use for each product, FOGRA suggests using 
the following resolution settings in the table below.

Item Size Viewing Distance Resolution (PPI)

Postcard 4” x 6” 8” 860
Letter 8.5” x 11” 14” 500
Poster 36” x 48” 60” (5ft) 300
Transit Bus Shelter Ad 47” x 68” 82” (7ft) 150
Wall Graphics 120” x 150” 60” (5ft) 150
Semi Trailer 576” x 120” 588” (49ft) 20
Billboard 588” x 168” 661” (51ft) 15
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Large Format Printing

120” x 150” Wallgraphic 

Resolution 165 PPI at 100%
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Large Format Printing

Viewing Conditions

The viewing conditions of a graphic affect how likely a viewer will notice low-resolution 
artifacts like pixelization and jagged edges. Therefore questions like the ones below will need 
to be taken into consideration:

Is there ample illumination? Will it be moving? Will the viewer be moving? Is it possible that 
the viewer may be much closer than the estimated viewing distance.

For example, consider an interior wall graphic and a semi-trailer graphic that have the same 
dimensions. The interior wall graphic will be well lit and viewed close up. In this instance a 
higher resolution is necessary. The semi-trailer graphic would not need as high of a resolution 
since it would be moving as the semi drives and the lighting conditions change as the daylight 
changes.

Type of Image

A soft focus or low contrast image can utilize a lower resolution, whereas an image with 
sharp edges and fine detail will show the effects of low resolution much more predominantly. 
Does the image have elements with a high degree of detail such as hair or fabric? Fine details 
require higher resolutions to render properly.

We recommend using the resolution settings in the table on page 10 as a starting point. The 
three factors that affect image resolution (Viewing Distance, Viewing Conditions, & Type of 
Image) can affect each project differently.
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Large Format Printing

Scaling Files

Not all documents can be created at the final output size. This is due to the limitations of 
the artboard size in the Adobe Creative Suite. When the final output size is larger than the 
artboard size prepare the file at a scale of 50%, 25%, or 10%. Please label the scaling factor 
used in the slug area of the document. This will allow for easy calculation of sufficient image 
resolution and bleed allowances. See examples below.

Examples for 50% Scale
Printed size 24ft X 12ft (288” x 144”)
Document set-up 12ft x 6ft (144” x 72”)

Image Resolution:
Document size = 300 PPI
Printed size = 150 PPI

Bleed Amount: 
Document size = 1”
Printed size = 2”

Examples for 25% Scale
Printed size 24ft X 12ft (288” x 144”)
Document set-up 6ft x 3ft (72” x 36”)

Image Resolution:
Document size = 600 PPI
Printed size = 150 PPI

Bleed Amount: 
Document size = 0.5”
Printed size = 2”
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Large Format Printing

Image Handling

Placed RGB images will be converted to CMYK formatted images in the PDF export process. 
It is advisable that designers look at the CMYK formatted images in the PDF before you send 
the files to the printer. 

Our colour managed workflow is based on North American industry standards. 

Please ensure that the placed images contain enough resolution. It is advisable to print images 
with a minimum of 120 ppi (pixels per inch) at final size. Please see the table on page 10 for 
product-specific recommendations.

If your wide format project is colour critical, please ask your Sales Representative to include  
a printed proof in the estimate. A colour critical section of the job or a proof at reduced size 
can be provided foe evaluation of image quality and colour.

Fonts

All fonts should be typeset in Illustrator/InDesign, not Photoshop.

Important: For wide format printing projects it is recommended to outline all fonts. This will 
allow for more stable file processing.

If fonts are being coloured black, the file should be set up to 100% black only. Do not apply a 
stroke to fonts.

InDesign Illustrator
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Large Format Printing

PANTONE (Spot) Colours

PANTONE colours will be converted to CMYK for digital large format printing as the printing 
process will not accommodate PANTONE spot colours. PANTONE spot colours can be utilized 
on our screen presses. Hemlock Display requires the files be built with PANTONE spot colours 
when a project demands a close colour match. If a PANTONE spot colour match is important 
for your large format printing project, please ask your Sales Representative for an estimate 
that includes a printed test or proof of the file before printing the live project.

White Ink Set-Up

The white ink channel in digital large format printing serves as a semi-opque option for CMYK 
printing on transparent substrates. Two scenarios are possible:

Spot White: Only certain parts of the printed area are to be blocked out with white ink (non- 
transparent areas). In this case a spot colour channel must be set-up in the document and 
named Spot1. The ink density is set to 100%. All spot white areas must be Set to Overprint 
prior to submitting files for output.

Flood White: The entire print area is to be blocked out with white ink. In this case no special 
file preparation is required but a Flood White must be specified/requested in the print order.

Example of spot white on clear acrylic Example of flood white on clear acrylic.
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Document Set-Up for Projects with Dielines or Contour Cut lines

When your project will be diecut, make the trim size of your document the same dimensions 
as the finished size after diecutting. When creating the dieline, create a swatch named  
CutContour that is defined as a spot colour. Give the dieline a stroke width of 1 point. The cen-
ter of the stroke is the position of the cut, so the dieline stroke should center on the trim size 
of the document when positioning the dieline artwork. Dieline areas must be Set to Overprint 
prior to submitting files for output. 

If scores are required, then a separate Score spot color needs to be defined.

Dieline Size = Trim Size.

Be sure to set bleed to at least .25" on all sizes. 

solid magenta			  = cut
solid green			   = score
solid yellow			   = perforations

Bleed 
 

Trim 
 

Spot Pallete from InDesign 

Use as few nodes as possible when creating complex dielines.

too many nodes  removing extra nodes

BEFORE AFTER

Large Format Printing
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Large Format Printing

Cut Lettering

When creating files for cut lettering, the cut path must be a vector (no .png or image files). Set 
small text no less than 30pt. Text set smaller than 30pt will not reproduce well. Please contact 
your Sales Representative to discuss your project if you have concerns. 

3D Lettering

Please note that small inside corners on 3D letters will become rounded to a 4mm radius once 
cut on a router table to accommodate the diameter of the milling bit.

Example of 3D Lettering

Original letter Letter after being cut on router table
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Large Format Printing

Gradients

Gradients are smooth blends from one colour to another. They can add depth and visual 
interest to a design. Producing smooth gradients without noticeable abrupt changes in colour 
(sometimes referred to as ‘stepping’ or ‘banding’) can sometimes be difficult, depending on 
several factors:

•	 The amount of colour shift vs. the length of the gradient
•	 The output device and media type
•	 Other elements in the file (transparency, blending, etc.)
•	 For producing gradients in Illustrator, see Adobe’s help document ‘Printing gradients, 

meshes, and color blends’. In general, gradients created in Photoshop are more reliable, but 
can increase your file sizes significantly.
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Large Format Printing

Screen Printing

Process colour screen printing has its own unique challenges. File preparation for screen 
printing differs slightly than Large Format digital printing. Follow these tips below for the best 
results:

•	 Type should be larger than 7pt (9pt for reverse type and type with fine serifs)
•	 Make sure grey and black elements are colours with Black only (C:0 M:0 Y:0 K:100)
•	 When creating areas of flat solid colour, ensure one of the colour channels set at either 

100% or 0% (eg. red: C:0 M:100 Y:100 K:0)
•	 Areas of colour made up of screens of all 4 colours (CMYK) could show a moire pattern 

and should be avoided.

Black Versus Rich Black

When designing a screen print project with process colours (CMYK) which have large areas of 
black, such as a solid black background or large black type, it is often desirable to use a CMY 
boost under the black. A boosted Black appearers blacker. Boosting Black allows the flexibility 
to achieve the desired colour density on the printing press. Hemlock Display’s preferred Rich 
Black is 15% Cyan, 15% Magenta, 15 % Yellow, 100% Black.

•	 Type smaller than 18pt and rules that are thinner than 3pt should not be boosted, but 
instead be 100% black only.
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File Format 

A large format print estimate is based on submitting print-ready PDF to Hemlock Display’s  
specifications. Please refer to the next paragraph.

Exporting Print-Ready PDF Documents for Large Format Printing

In the pull-down menu, choose File > Export, a window will ask where to save the PDF file. 
Save the file to the appropriate location. An “Export Adobe PDF” window will open with  
options to generate a PDF with optimal print compliance. The screen shots below illustrate  
the settings required for large format printing. An Adobe PDF preset can be requested.

• The pdf export settings are available for download at: pdf.hemlock.com

Select Acrobat 8/9 (PDF 1.7) under Compatibility. 
This setting allows for transparency

Set your image downsampling to Do Not 
Downsample and compression to ZIP.

Large Format Printing
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Exporting Print-Ready PDF Documents for Large Format Printing (cont’d)

Prior to sending the PDF to Hemlock Display, it is advised to view the exported PDF in Acrobat 
with the Output Preview tool on. This will provide you with a final look at your PDF to confirm:

Set your Marks and Bleeds to 0.25” Save Preset  for future use.

With the correct PDF Export Settings, each of the critical prepress settings will be correct and 
your files will process properly.

	ü Correct amount of Bleed
	ü Resolution of the file
	ü Trim marks must be outside Bleed Margins
	ü No tags or registration marks inside the 

bleed margins

	ü Colour mode is CMYK only 
	ü Critical colours are Pantone swatches 

from Pantone Solid Coated swatch book
	ü Dieline or cutlines are set to CutContour
	ü White ink is set to Spot1

Large Format Printing
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Packaging Files

Both InDesign and Illustrator features a Package function (File > Package) that will gather your 
file along with all requred links and fonts. 

If any changes need to be made at Hemlock Display, using the Package function will give 
our prepress operators the flexibiltity to make changes and output the file in a timely matter 
avoiding production delays. Transparency issues are a common problem at the RIP processing 
stage (just before printing). Having the native files will allow us to quickly fix the problem, 
instead of waiting for new files. 

Supported file types

•	 Adobe InDesign CS
•	 Adobe Illustrator CS
•	 Adobe Photoshop CS
•	 Print-ready PDF files*

*Please note that we cannot edit all PDF files. If your job requires screen printing, die-cutting 
or editing, we may require source files.

Large Format Printing



25

Notes




